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Purpose 

This document includes important, late-breaking information about Oracle’s Hyperion® Smart 
View for Office™ Release 9.3.1.1. Review this information thoroughly before installing Smart 
View Release 9.3.1.1. 

This release of Smart View is an English only release. 

New Features 

Smart View 9.3.1.1 supports Microsoft Office 2007 Excel, Word, and PowerPoint. Note: in Office 
2007 products, you can open and use Smart View documents that were created in Microsoft 
2000 and 2003. However, you may lose POV or other data if you use earlier versions of Office 
to open Smart View documents that were created in Office 2007. 

Installation Updates 

Software Requirements 

The software requirements for client computers are listed below. 

Note: You must follow the supported client and operating system requirements. 

The Client 

Supported Client Software  

• Microsoft Office 2000 
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• Microsoft Office XP (2002) 

• Microsoft Office 2003 (smart tags require Office 2003 or later) 

• Microsoft Office 2007 

Supported Operating Systems 

• Windows Vista  

• Windows XP Professional SP 2 

• Windows 2003 SP 1 

• Windows 2000 Professional, SP 4 

• Windows 2000 Server, SP 4  

Hyperion Product Compatibility Matrix 

The following table provides a list of Hyperion products and release numbers that support 
Smart View Release 9.3.1.1. 

Hyperion Product Release 

Hyperion® Financial Management – System 9 4.1.1.3, 4.0.5.3, 9.2, 9.3.0.3.5. 9.3.1 

Hyperion® Planning – System 9 4.1.1, 9.2, 9.3.0.1.0, 9.3.1, 9.3.1.1 

Note: Offline Planning 9.2 and prior 
releases do not work with Smart View 
Release 9.3.0.1.0 or later. 

Hyperion® Essbase® – System 9 7.1.6, 9.2, 9.3, 9.3.0.1.0. 9.3.1, 
9.3.1.1 

Hyperion® Provider Services 9.3.1 

Hyperion® Reporting and Analysis – System 9 9.2, 9.3, 9.3.0.1.0, 9.3.1 
 

Top 

Instructions for Manual Deployment 

If you are upgrading from Smart View 9.3.1 to 9.3.1.1, you must perform the deployment steps 
for data providers as described below. 

Financial Management 
1. On the Financial Management provider machine, copy both smartview.exe and 

version.xml to the HFM\Web\HFMOfficeProvider\ folder, replacing the corresponding files 
from your previous installation. 

2. If Always warn when client version is newer is enabled in the Financial Management 
Web Server Configuration Utility for Smart View, users can install Smart View on their client 
machine as directed in Client Installation on page 4. 
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Planning 
These instruction assume that you have installed Planning 9.3.1.1 (see the Hyperion Planning –
System 9 Release 9.3.1.1 Readme). Download the installation files from: 

 http://{localhost}:{8300}/HyperionPlanning/smartview.exe 

1. In Planning, select Administration > Manage Properties > System Properties and 
enter the following setting: 
 
SMART_VIEW_VERSION=9.3.1.1.0 
SMART_VIEW_INSTALL_URL=<URL location of SmartView.exe> 
 
For example 
 
SMART_VIEW_INSTALL_URL=http://<localhost>:<8300>/HyperionPlanning/smartview/Sm
artView.exe  

2. Restart the Planning server. 

3. Install the Smart View client as directed in Client Installation on page 4. 

Provider Services 
For Provider Services 9.3.1.0.0 only: On the Provider Services server machine, administrators 
perform the following steps: 

1. Copy both SmartView.exe and version.xml to the <APS_HOME>\redist\ folder, replacing 
the corresponding files from your previous installation. 

2. Open version.xml in the <APS_HOME>\redist\ folder and replace the line, 
“Smartview.exe” with: 

http://<ServerName>:<PortNumer>/aps/SmartView?downloadClient 

<ServerName> is the name of the computer on which Provider Services is installed, and 
<PortNumber> is the port number on which Provider Services listens.  

For example: 

http://apssvr1:13080/aps/SmartView?downloadClient 

3. Install the Smart View client as directed in Client Installation on page 4. 

Reporting and Analysis 
1. On the Reporting and Analysis Hyperion® Workspace web application server machine, copy 

both SmartView.exe and version.xml to the BIPlus\AppServer\InstalledApps\ 
workspace_static\SmartView folder and replace the corresponding files from your 
previous installation. 

2. Rename version.xml to SmartViewVersion.xml. 

3. Install the Smart View client as directed in Client Installation on page 4. 

Top 
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Client Installation 
At each client machine, users perform the following steps: 

1. Launch Excel and select Hyperion > Connection Manager and connect to a data source.  

2. In New Smart View client version available, select the Click here to install link.  

3. In File Download, click Open to start the installation.  

4. If a Microsoft Excel Security Warning dialog box is displayed, click Run. 

5. When prompted, close Excel and all other Microsoft Office applications, then click OK in the 
Installation Warning to proceed. 

6. In the Smart View installer, click Next to begin the installation, then follow the prompts. 

When the installation is complete, you may be prompted to restart your computer, after 
which you can start Excel and select Hyperion > About to verify the new version.  

Top 

Known Issues  

• When you try to save data that you have entered in an offline Smart View worksheet, you 
may get a "Protected Sheet" error that prevents you from saving the data, even if the 
worksheet is not protected. This happens only with Office 2000. (8-648234013) 

• After installation of Smart View the first copy and paste data point action may cause Excel 
to terminate abnormally. Avoidance: Save the Excel document, copy data points, close the 
Excel document. Upon opening, the Excel document (and any subsequent Excel document) 
the issue is resolved, and you can copy and paste data points as desired. This process does 
not need to be repeated after the first time. (8-636533601) 

• Adding blank rows or columns to the Query worksheet which result in an invalid query while 
connected to Hyperion Financial Management may result in an abnormal termination. (8-
621830751) 

• When you select the Range filter and Generation is set to 0, all level 0 members are listed 
instead of members from the selected range. (8-596526619) 

• Populating cells using the Excel autofill feature to submit data does not work properly in 
Smart View. (8-587318062) 

• The Help button for Cell Text in Smart View opens the wrong help topic. Workaround: 
open the online help from the Hyperion menu and search for Cell Text. (8-579471333) 

• When installing on Vista, you are not prompted for administrator privileges at the beginning 
of installation as expected. Instead, you get an error message during installation that you 
do not have sufficient privileges. Workaround: right-click smartview.exe and select Run 
as administrator. You will then be prompted to supply administrator credentials. (8-
577431001) 

• When Use Excel Formatting is selected in the Options dialog box, performing Undo removes 
grid formatting. (8-567378861) 
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• Function links are not automatically updated in spreadsheets that are shared. This is an 
Excel limitation. (8-520808921) 

• If you enter a function into a cell after editing but before refreshing the grid, it becomes 
free-form mode and the displayed data cannot be submitted. (1-176013641) 

• Undo functionality in data forms is limited to data changes only. (1-170535057) 

• When you change the alias table, comments and formulas may not retain their position in 
the grid after you refresh. (1-151866605)  

• In some cases, a summary time period is not calculated correctly by a formula if the 
formula references a value whose position changes in the grid when you redesign the form 
(1-72494176) 

• When using the HsSetVal function in a cell that references another cell also containing the 
HsSetVal function, then processing Smart View functions cell by cell is not currently 
supported. (8-628314871) 

• On non-English Windows machines, the decimal separator key in the Function Builder data 
textbox does not work for HsSetValue. Workaround: use the keyboard to enter the 
decimal separator. (1-175450491) 

• Copy/paste does not work when all dimensions are on the grid and the POV is empty. 
Workaround: keep one dimension in the POV for copy/paste. (8-629063091) 

• If you attempt to delete the POV toolbar using Excel's Customize Toolbar functionality (View 
> Tools > Customize), Excel terminates abruptly. (8-632838591) 

Top 

Essbase 

• For Essbase databases, if an alias table is added after you are connected to a sheet, you 
must exit Excel and reconnect to Smart View to view the new alias table. (1-131920201) 

• If Suppress Underscore Character is selected, running a query results in an error. (8-
537588671) 

• In non-unique outlines, changing an alias table results in the correct change in dimension 
names but not in member names. (8-617491277). 

• When a large number of Smart View functions is retrieved at once, Smart View retrieves 
zeros in all cells. This is related to The Windows 2003 network socket TcpTimedWaitDelay. 
(SR 8-618124231). Fix: 

1. Using the regedit command, access the 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ Services\TCPIP\Parameters registry 
subkey, and create a new REG_DWORD value named TcpTimedWaitDelay. 

2. Set the value to decimal 30, which is Hex 0x0000001e. This value sets the wait time to 
30 seconds. 

3. Using the regedit command, access the 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ Services\TCPIP\Parameters registry 
subkey, and create a new REG_DWORD value named MaxUserPort.   

4.   Set this value to at least decimal 32768.     

5.   Stop and restart your system.  



Hyperion Smart View for Office Release 9.3.1.1 Readme 

 
6 

Planning 

• When a form is opened in Excel 2000 and connected to a Planning server, changing data 
values (writable cell) within the form may generate an error message related to "Protected 
Sheet," and the cell color does not turn dirty. Users may ignore the message. (8-
648234013) 

• For spreading functionality to work on a saved data form, the data form must be connected 
to a Planning provider and refreshed. 

• Planning only supports data forms; Planning does not support the use of Microsoft Word or 
PowerPoint. 

• Business rules created in Planning may behave differently offline and online; they should 
behave the same in both modes. (8-530854073) 

• In some cases, values calculated by formula overwrite enumeration values. (1-15832460) 

• STP is not recalculated if Suppress #Missing is selected and supporting details are deleted. 
(1-173078797) 

• Dynamically calculated members are not brought offline when invoking offline mode in 
Planning. This does not affect data entry and all dynamically calculated members will reflect 
properly when data is synchronized back to the server. (8-525531217 

• To ensure that the Smart View Take Offline Wizard works with Windows® Vista™ Business 
Edition, you must copy the file mscomct2.ocx to the system32 directory and register the file 
in the system registry. For more information see http://msdn2.microsoft.com/en-
us/vbrun/ms788708.aspx, “Tested and Not Shipping in Windows Vista”. (8-632556423) 

• In Business Rules, root members that fall outside the set limit should be disabled, but they 
are not. (8-526686290) 

Top 

Hyperion Financial Management 

• The Smart View 9.3.1 client is currently not backwards compatible to Financial Management 
9.2.x data sources.  

• When you install Smart View on Windows Vista, you may get a warning: "Open File - 
Security Warning. The publisher could not be verified. Are you sure you want to run this 
software? … Unknown Publisher." You can safely proceed. (8-584657541) 

• When you migrate an active workbook in Financial Management, functions are not migrated 
properly. Instead of the expected Need Refresh status, the grid is blank. To display the 
functions, click Refresh. (8-587603231) 

• To view the Supports Allocation cell style, open the Options dialog box. In the Cell Styles 
tab under Data, move the Supports Allocation to a higher priority than that of the Writeable 
style. (8-603972511) 

Top 

Reporting and Analysis 

• After you import Hyperion® Web Analysis – System 9 or Hyperion® Financial Reporting – 
System 9 reports as query-ready for refresh against Oracle’s Hyperion® Essbase®  - System 
9, any subsequently imported fully-formatted reports cannot be refreshed in that Office 
session. (8-617741282) 
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• If you have two Reporting and Analysis active connections, one of which is the default, 
using Refresh All in a document in the connection that is not the default may cause Excel to 
freeze. Workaround: make the preferred Reporting and Analysis connection the default or 
use a different Hyperion provider as the default connection. (8-624124355) 

• Pop-up blocking must be disabled for the Reporting and Analysis Workspace server to 
enable import of Reporting and Analysis content using Smart View. (1-404795681) 

• When you import Web Analysis or Financial Reporting reports as query-ready for refresh 
against Essbase data sources, Dynamic Time Series and non-unique members are not 
supported. (8-617741153, 8-617741218) 

• In Word and PowerPoint, the Hyperion > Reporting and Analysis Document menu items are 
enabled prior to activating a connection to a Reporting and Analysis provider. You must 
create and activate a connection before using them. 

• When you try to import content from a job that has failed to execute, you should get an 
error message that the job failed to execute. Instead, the error message states that you 
cannot connect to the provider, which is incorrect and misleading. (1-119406838) 

Financial Reporting 

• Financial Reporting reports imported and saved using Smart View 9.2.0.3 with BI+ 9.2.0.3 
cannot be refreshed after upgrading to Smart View 9.3 and BI+ 9.3 and later. (In 9.3.1, 
BI+ is renamed to Reporting and Analysis). To refresh you must first re-import the report. 
(8-529120014) 

• In order to import Financial Reporting content into Word and PowerPoint as images, the 
Oracle’s Hyperion® Financial Reporting – System 9 Print Server must be configured with 
Ghost script and not Distiller. (8-513820517) 

Web Analysis 

• When you import an Oracle’s Hyperion® Web Analysis – System 9 document that contains a 
page with no data, you may get a message "Error accessing import data." (8-615906203) 

Workspace  

• Smart View cannot connect to an Oracle’s Hyperion® Workspace server configured for 
Oracle single sign-on.  

• Word export files created by Hyperion® SQR Production Reporting – System 9 cannot be 
viewed within the Workspace. (8-524268641) 

Top 

SQR Production Reporting 

• When importing Oracle’s Hyperion®  SQR Production Reporting content into Excel, Word, or 
PowerPoint, using the scroll bar on the left side of the Preview screen to navigate to 
different pages can cause the output page number in the Page drop-down list box to differ 
from the actual page you are viewing. (1-400611278) 

• At the time of import or edit, the preview page might indicate that the report has an extra 
page in the “x of y” page drop-down control. If you select the last page number, the 
preview will position the viewer toward the bottom of the last actual page. (8-518887931) 

Top 
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Defects Fixed in this Release  

• When an Excel workbook is loaded with a Planning or Oracle’s Hyperion® Financial 
Management – System 9 data form, using another Excel worksheet within the same 
workbook for native Excel usage will cause Excel to terminate abruptly. (8-634709026) 

• The Print POV in Smart View does not function. (8-629252221) 

Reporting and Analysis 

• Excel terminates abruptly when you import a report in query-ready format in Oracle’s 
Hyperion® Reporting and Analysis – System 9. This happens when the POV is empty and 
you are using the default connection. Workaround: establish a connection before importing 
or use a new worksheet for the import. (8-629689421) 

Planning 

• Excel sheets with Reports turn black after a Planning data form is launched in a separate 
worksheet. This occurs when Smart View overwrites the Excel color palette to accommodate 
application-specific colors not supported by Excel. Workaround: Select “Use Excel 
Formatting” on the Options dialog box. (8-570582790) 

• If you double-click a blank worksheet while connected to an Oracle’s Hyperion® Planning – 
System 9 data source, Excel may terminate abruptly. Note: Although Smart View does not 
support ad hoc functionality in Planning, Excel should not terminate. (8-629436761) 

Top 

Documentation Updates 

Accessing Hyperion Product Documentation 

• The most recent version of each Hyperion product guide is available for download 
from the Documentation area of the Oracle Technical Network (OTN) Web site 
(http://www.oracle.com/technology/index.html).  

Documentation is also available from the Oracle E-Delivery Web site 
(http://edelivery.oracle.com/EPD/WelcomePage/get_form). Please note that 
individual product guides are available for download on the Oracle Technical Network 
(OTN) Web site only. 

• When you open HTML help using Internet Explorer 7 in Microsoft Windows Vista, the initial 
help page displays without the Content, Index, and Search tabs. Right-click the Internet 
Explorer Information Bar and choose “Allow Blocked Content” to display the Content, Index, 
and Search tabs.  

Other Documentation Updates 

• POV: The Smart View for Office User’s Guide and online help refer to the Options menu 
(consisting of Pivot to POV, Pivot to Row, Pivot to Column, and Select Members) on the POV 
toolbar. In Oracle’s Hyperion® Smart View for Office 9.3.1, the Options menu was removed. 
You can perform the actions by dragging and dropping, or selecting members via the 
browse button or the Dimension drop down menu in the POV toolbar. This error appears in 
the “Filtering Members” and “Working with Dynamic Time Series” sections (chapter 7 of the 
User’s Guide). (8-641535213) 
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• Planning: Chapter 1, Introduction to Smart View, Login Requirements. When you log in to 
Smart View, a warning message is displayed if the Smart View release and the Planning 
release differ. If you see either of the following messages at login, contact the 
administrator: 

• You are connecting to a server which is of an older version. 

• There is a new version available. Do you want to install it? 

 Top 



Hyperion Smart View for Office Release 9.3.1.1 Readme 

 
10 

Hyperion® Smart View for Office™  
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Readme 

Readme File 
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Purpose 

This document includes important, late-breaking information about Hyperion Smart View for 
Office Release 9.3.1.0.0. Review this information thoroughly before installing Smart View 
Release 9.3.1.0.0. 

New Features 

A list of new features is available in the Hyperion Smart View for Office New Features. See 
Accessing Hyperion Product Documentation. 

Installation Updates 

Software Requirements 

The software requirements for client computers are listed below. 

The Client 
Note: You must follow the supported operating system requirements. 

Supported Client Software  

• Microsoft Office 2000 

• Microsoft Office XP (2002) 

• Microsoft Office 2003 (smart tags require Office 2003 or later) 
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Supported Operating Systems 

• Windows Vista  

• Windows XP Professional SP 2 

• Windows 2003 SP 1 

• Windows 2000 Professional, SP 4 

• Windows 2000 Server, SP 4  

Hyperion Product Compatibility Matrix 

The following table provides a list of Hyperion products and release numbers that support 
Smart View Release 9.3.1.0.0. 

Hyperion Product Release 

Financial Management 4.1.1.3, 4.0.5.3, 9.3.0.3.5. 9.3.1 

Planning 4.1.1, 9.2, 9.3.0.1.0, 9.3.1 

Note: Offline Planning 9.2 or prior 
releases does not work with Smart View 
Release 9.3.0.1.0. 

Essbase 7.1.6, 9.2, 9.3, 9.3.0.1.0. 9.3.1 

Note: You must install Hyperion Provider 
Services 9.3 to work with Essbase 9.3.  

Hyperion Provider Services 9.3.1 

Reporting and Analysis Workspace 9.2, 9.3, 9.3.0.1.0, 9.3.1 

 

Top 

Known Issues 

• Adding blank rows or columns to the Query worksheet which results in an invalid query 
while connected to Hyperion Financial Management may result in an abnormal termination. 
(8-621830751) 

• When you select the Range filter and Generation is set to 0, all level 0 members are listed 
instead of members from the selected range. (8-596526619) 

• Populating cells using the Excel autofill feature to submit data does not work properly in 
Smart View. (8-587318062) 

• The Help button for Cell Text in Smart View opens the wrong help topic. Workaround: open 
the online help from the Hyperion menu and search for Cell Text. (8-579471333) 

• When installing on Vista, you are not prompted for administrator privileges at the beginning 
of installation as expected. Instead, you get an error message during installation that you 
do not have sufficient privileges. Workaround: right-click smartview.exe and select Run as 
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administrator. You will then be prompted to supply administrator credentials. (8-
577431001) 

• When Use Excel Formatting is selected in the Options dialog box, performing Undo removes 
grid formatting. (8-567378861) 

• Function links are not automatically updated in spreadsheets that are shared. This is an 
Excel limitation. (8-520808921) 

• If you enter a function into a cell after editing but before refreshing the grid, it becomes 
free-form mode and the displayed data cannot be submitted. (1-176013641) 

• Undo functionality in data forms is limited to data changes only. (1-170535057) 

• When you change the alias table, comments and formulas may not retain their position in 
the grid after you refresh. (1-151866605)  

• In some cases, a summary time period is not calculated correctly by a formula if the 
formula references a value whose position changes in the grid when you redesign the form 
(1-72494176) 

• When deleting supporting detail items, a confirmation message should be displayed; 
however, it is not. (3-396897) 

• Processing SmartView functions cell by cell so that you can reference the result from the 
other is not currently supported. (8-628314871) (SR 8-628314871) 

• In operating systems other than English, the decimal separator key in the Function Builder 
data textbox does not work for HsSetValue. Workaround: use the keyboard to enter the 
decimal separator. (1-175450491) 

• Copy/paste does not work when all dimensions are on the grid and the POV is empty. 
Workaround: keep one dimension in the POV for copy/paste. (8-629063091) 

• If you attempt to delete the POV toolbar using Excel's Customize Toolbar functionality (via 
View > Tools > Customize), Excel terminates abruptly. ( 8-632838591) 

• The Print POV in Smart View does not function. (8-629252221) 

• When an Excel workbook is loaded with a Planning or HFM form, using another Excel 
worksheet within the same workbook for native Excel usage will cause Excel to terminate 
abruptly. (8-634709026) 

Top 

Essbase 

• For Essbase databases, if an alias table is added after you are connected to a sheet, you 
must exit Excel and reconnect to Smart View to view the new alias table. (1-131920201) 

• If suppress underscore character is selected, running a query results in an error. (8-
537588671) 

• In non-unique outlines, changing an alias table results in the correct change in dimension 
names but not in member names. (8-617491277). 

• Because of Retrievals in Smart View return zeroes in all cells. This is related to The Windows 
2003 network socket TcpTimedWaitDelay. (SR 8-618124231). Fix: 

1. Using the regedit command, access the 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ Services\TCPIP\Parameters registry 
subkey, and create a new REG_DWORD value named TcpTimedWaitDelay. 
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2. Set the value to decimal 30, which is Hex 0x0000001e. This value sets the wait time to 
30 seconds. 

3. Set the value to decimal 30, which is Hex 0x0000001e. This value sets the wait time to 
30 seconds.     

4. Using the regedit command, access the 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ Services\TCPIP\Parameters registry 
subkey, and create a new REG_DWORD value named MaxUserPort.     

5.   Set this value to at least decimal 32768.     

6.   Stop and restart your system.  

Top 

Planning 

• Business rules created in Planning may behave differently offline and online; they should 
behave the same in both modes. (8-530854073) 

• In some cases, values calculated by formula overwrite enumeration values. (1-15832460) 

• STP is not recalculated if Suppress #missing selected and supporting details are deleted. (1-
173078797) 

• Excel sheets with Reports turn black after a Planning data form is launched in a separate 
worksheet. This occurs when Smart View overwrites the Excel color palette to accommodate 
application-specific colors not supported by Excel. Workaround: Select Use Excel Formatting 
on the Options dialog box. (8-570582790) 

• Dynamically calculated members on a data form are not displayed in offline mode. (8-
525531217) 

• To ensure that the Smart View Take Offline Wizard works with Windows® Vista™ Business 
Edition, you must copy the file mscomct2.ocx to the system32 directory and register the file 
in the system registry. For more information see http://msdn2.microsoft.com/en-
us/vbrun/ms788708.aspx, “Tested and Not Shipping in Windows Vista”. (8-632556423) 

• In business rules, root members that fall outside the set limit should be disabled, but they 
are not. (8-526686290) 

• If you double-click on a blank worksheet while connected to a Planning datasource, Excel 
may terminate abruptly. Note: Smart View does not support ad hoc functionality in 
Planning, but Excel should not terminate. (8-629436761) 

Top 

Hyperion Financial Management 

• The Smart View 9.3.1 client is, currently, not backwards compatible to Hyperion Financial 
Management 9.2.x data sources.  

• When you install Smart View on Windows Vista, you may get a warning: "Open File - 
Security Warning. The publisher could not be verified. Are you sure you want to run this 
software? ..... Unknown Publisher." (8-584657541) 
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• When you migrate an active workbook in Financial Management, functions are not migrated 
properly. Instead of the expected Need Refresh status, the grid is blank. To display the 
functions, click Refresh and they appear. (8-587603231) 

• To view the Supports Allocation cell style, open the Options dialog box. On the Cell Styles 
tab under Data, move the Supports Allocation to a higher priority than that of the Writeable 
style. (8-603972511) 

Top 

Reporting and Analysis 

• After you import Web Analysis or Financial Reporting reports as query-ready for refresh 
against Essbase, any subsequently imported fully-formatted reports cannot be refreshed in 
that Office session. (8-617741282) 

• If you have two Reporting and Analysis active connections, one of which is the default, 
using Refresh All in a document in the connection that is not the default may cause Excel to 
freeze. Workaround: make the preferred Reporting and Analysis connection the default or 
use a different Hyperion provider as the default connection. (8-624124355) 

• Pop-up blocking must be disabled for the Reporting and Analysis workspace server to enable 
import of Reporting and Analysis content using Smart View. (1-404795681) 

• When you import Web Analysis or Financial Reporting reports as query-ready for refresh 
against Essbase datasources, Dynamic Time Series and non-unique members are not 
supported. (8-617741153, 8-617741218) 

• In Word and PowerPoint the Hyperion > Reporting and Analysis Document menu items are 
enabled prior to activating a connection to a Reporting and Analysis provider. You must 
create and activate a connection before using them. 

• When you try to import content from a job that has failed to execute, you should get an 
error message that the job failed to execute. Instead, the error message states that you 
cannot connect to the provider, which is incorrect and misleading. (1-119406838) 

• Excel terminates abruptly when you import a report in query-ready format. This happens 
when the POV is empty and you are using the default connection. Workaround: establish a 
connection before importing or use a new worksheet for the import. (8-629689421) 

Top 

Financial Reporting 

• Financial Reporting reports imported and saved using Smart View 9.2.0.3 with BI+ 9.2.0.3 
cannot be refreshed after upgrading to Smart View 9.3 and BI+ 9.3 and later. (In 9.3.1, 
BI+ is renamed to Reporting and Analysis). To refresh you must first re-import the report. 
(8-529120014) 

• In order to import Financial Reporting content into Word and PowerPoint as images, the 
Financial Reporting Print Server must be configured with Ghost script and not Distiller. (8-
513820517) 

• When you import reports, numbers default to a number value and two decimal places.(3-
392011) 

Web Analysis 

• When you import a Web Analysis document that contains a page with no data, you may get 
a message "Error accessing import data." (8-615906203) 
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Workspace 

• Smart View cannot connect to a Workspace server configured for Oracle single sign-on. (8-
579471333) 

• Word export files created by SQR can not be viewed within the Workspace. (8-524268641) 

Production Reporting 

• When importing Production Reporting content into Excel, Word, or PowerPoint, if you are 
using the scroll bar on the left side of the Preview screen to navigate to different pages, 
then the output page number in the Page drop-down list box does not reflect the actual 
page you are viewing in the Preview screen. (1-400611278) 

• At the time of import or Edit, sometimes the preview page indicates that the report has an 
extra page in the “x of y” page drop-down control. If you select the last page, the preview 
will position the viewer toward the bottom of the last actual page. (8-518887931) 

Top 

Defects Fixed in this Release 

• If you load a Data Form that has {Regional.[Hierarchy]} as the POV filter, Search does not 
work in the Member Selection dialog when you load it into Smart View. (8-617725204) 

• In data entry forms, the data retrieved does not always reflect the dimension specified in 
POV. (8-612712370) 

• You cannot change the alias table for a grid saved with an alias. (8-554782981) 

• If you use the Excel Replace All option, replaced members revert back to original name after 
you refresh. (8-510378042) 

• The Excel screen shakes during a refresh if the POV toolbar is docked. (1-194434059) 

• Excel formatting is preserved only on refresh, not zoom and pivot operations. (8-
597471191) 

Essbase 

• In HVE, the database connection is lost when you use Quick filters. (8-598643978) 

• Smart View may remove your sheet formatting during data submission. (8-553473271) 

Top 

Planning 

• When users attempt to run business rules which are connected to a form through 
SmartView, the Run Time Prompts should be pulled from the form where applicable. (8-
595446412) 

• It should be possible to display member alias names as well as member names in the 
Business Rules Member Selection dialog box. (8-567236345) 

• When a user opens a form through Smart View, their POV should default to the one they've 
last used. (1-208058467) 

• In Business Rules, forms with Run on Save selected should be accessible from Smart View. 
(1-208058412) 
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• Because Smart View does not support substitution variables, does not use the VALUE from 
dropdown POV selections, and fails when all runtime prompts are set to "hide," passing 
parameters to business rules and running business rules on save do not function.  (8-
566156425) 

• Smart View ignores the "hide prompt" option set in Business Rules properties in the 
Planning web. (8-567090831) 

• Data is not saved when you delete a value if the cell selection is partially outside the 
Planning webform. (8-566076175) 

• In business rules, shared members are repeated in dimension lists when you are selecting 
argument prompts (8-542411726). 

• The Use Members on Form option does not work correctly when chosen for the Run on Save 
rule. (1-195224461) 

• Aliases are not displayed in the Business Rules Member Selection window if the option Show 
Alias in Member Selection is selected. (3-396407) 

Financial Management 

• Drilling via Smart View intermittently produces recursion of data. (8-594919110) 

Top 

Reporting and Analysis 

• In Interactive Reporting report sections containing images, the images are not imported to 
Excel.(8-564177128) 

• Smart View loses the session ID in the Smart View provider. (8-557392321) 

• Financial Reporting only: "Enhancement. During Import and Edit, documents using Grid 
Point of View or User Point of View always use the Point of View specified during import. 
Now you can revert to the Workspace Point of View by selecting Refresh Using Workspace 
Point of View." 

• If a Web Analysis report contains multiple grids, only the leftmost grid appears when it is 
opened in Smart View. (8-598161581) 

Top 

Documentation Updates 

Accessing Hyperion Product Documentation 

• The most recent version of each Hyperion product guide is available for download from the 
Documentation area of the Oracle Technical Network (OTN) Web site 
(http://www.oracle.com/technology/index.html).  

Documentation is also available from the Oracle E-Delivery Web site 
(http://edelivery.oracle.com/EPD/WelcomePage/get_form). Please note that individual 
product guides are available for download on the Oracle Technical Network (OTN) Web site 
only. 

• When you open HTML help using Internet Explorer 7 in Microsoft Windows Vista, the initial 
help page displays without the Content, Index, and Search tabs. Right-click the Internet 
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Explorer Information Bar and choose “Allow Blocked Content” to display the Content, Index, 
and Search tabs.  

Other Documentation Updates 

• The Smart View for Office User’s Guide and online help contain references to Microsoft 
Office 2007. Smart View does not support Office 2007 in 9.3.1, but will in an upcoming 
release. 

• In the 9.3.1 Smart View User's Guide, "password" is listed as a parameter for 
HypGetConnectionInfo() (p. 135). It is no longer a parameter in 9.3.1 (8-624308441) 

• In the Smart View for Office User’s Guide and online help, "Under General edit and 
refresh behavior, the following sentence should include the underlined text: 

If an Edit or Refresh results in additional Workspace pages, those pages are appended to 
the end of the document in Office." 

Top 
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